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Getting Started

Creating TencentDB for SQL Server

Instance
Last updated：2025-09-04 11:19:44

This document describes how to create an instance in the TencentDB for SQL Server console.

You have registered a Tencent Cloud account and completed identity verification. For more information, see 

Signing Up  and Identity Verification Guide .

1. Go to the TencentDB for SQL Server purchase page , complete the configurations in Select a basic 

configuration, Set network and database, and

Confirm the configuration info. Then, read and indicate your consent to the Terms of Service, confirm that 

everything is correct, and click Buy Now.


Step 1. Select a basic configuration


In this step, you can set the basic configuration and specification options for the instance. The specific 

settings are as follows:

Basic Configuration

Overview

Prerequisites   

Operation Steps

Creating an Instance   

Billing Mode: Pay-as-you-go.  

Region: We recommend that you choose the region closest to your end users to minimize access latency 

and improve download speed.

AZ: Select an AZ in the selected region. You can also use the AZ that is randomly allocated by the 

system.

Instance architecture: Support single-node, dual-node, and multi-node.

Storage Type:

When single-node architecture is selected, you can choose from premium cloud disk, SSD, balanced 

SSD, and enhanced SSD.

Note:

https://intl.cloud.tencent.com/document/product/378/17985
https://intl.cloud.tencent.com/document/product/378/3629
https://buy.intl.cloud.tencent.com/sqlserver#/
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Specs Configuration

In Chinese mainland, if you need SSD for your basic edition instances, submit a ticket  for 

application.

When two-node architecture is selected, you can choose from enhanced SSD, balanced SSD, and 

high-performance local SSD.

 For multi-node architecture, available storage types include Enhanced SSD and Balanced SSD.

 For a detailed description of each storage type and applicable scenarios, see Storage Types .

Database version: supports SQL Server 2008 R2, SQL Server 2012, SQL Server 2014, SQL Server 2016, 

SQL Server 2017 and SQL Server 2019 Enterprise and Standard version as well as SQL 2022 Enterprise 

version. The supported database versions vary by instance architecture. See the purchase page for 

details.

Disk encryption: For instances located in Shanghai, with storage type of Cloud Block Storage (CBS) and 

database version of SQL Server 2019/2022 Enterprise, the disk encryption feature can be used after 

applying for whitelisting . This feature is not supported in other regions or for other versions. If you need 

to use this feature, submit a ticket  for application. The disk encryption field will only be displayed after 

you apply for disk encryption.

Key source: This item is displayed when disk encryption is enabled. Currently, the default key source is 

provided by Tencent Cloud.

Number of Replica Nodes: If multi-node architecture is selected, you need to specify the number of 

replica nodes from 2 to 5. The settings is not required for single-node or dual-node architectures.

Multi-AZ Deployment: This option is available when a dual-node or multi-node architecture is selected. 

For multi-node architecture, it can only be set to enabled.

Enabled: Multi-AZ Deployment is enabled, requiring the selection of secondary AZs in the next step. 

Each secondary node can be assigned a secondary AZ. Note: If all secondary nodes are deployed in 

the same AZ, the AZ-level disaster recovery is not supported. Please choose different secondary 

AZs.

Disabled: Multi-AZ Deployment is not enabled. Currently, only Shanghai, Beijing, Guangzhou, and 

Hong Kong (China) support multi-AZ deployment. Multi-AZ is a physical zone that combines 

multiple single AZs in the same region, which is used to protect databases in case of instance faults 

or AZ interruptions.

Replica AZ: If multi-AZ deployment is enabled, select the replica AZ based on the available resources.

Type: The Dedicated type is supported.

Filter: You can quickly filter the needed CPU and memory specifications for the instance. By default, all 

CPU and memory specifications are selected.

Selected instances: The specification information of the selected instances are displayed, including 

specification type and specification.

https://console.intl.cloud.tencent.com/workorder/category
https://intl.cloud.tencent.com/document/product/238/46490
https://console.intl.cloud.tencent.com/workorder/category
https://console.intl.cloud.tencent.com/workorder/category
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Step 2. Set network and database

Instance Specifications: The detailed specification information is displayed, including the specification 

type, CPU, memory, maximum IOPS, supported AZs, and reference fees.

Storage Space: Select the required disk capacity.

Network: VPC is supported. For connectivity testing, see Network Environment . Both VPCs and subnets 

support fuzzy search.

Note:

We recommend that you place the CVM and TencentDB instances under the same account in 

the same VPC in the same region.

A subnet is a logical network space in a VPC. You can create subnets in different AZs in the 

same VPC, which communicate with each other over the private network by default. Even if 

you select a subnet in another AZ in the same region, the network latency will not be 

increased because the actual business connection adopts nearby access.

Security Group: A security group is a stateful virtual firewall capable of filtering. As an important means 

for network security isolation provided by Tencent Cloud, it can be used to set network access controls 

for one or more TencentDB instances.

Note:

You can either create new security groups or choose from existing ones. You can also locate the 

target group by fuzzy search.

Instance Name: Select Set After Creation or Set Now.

System Time Zone: China Standard Time (Beijing Time) is supported by default.

For the purchase of the two-node local disk instances, submit a ticket  to apply for the modification 

of the system time zone.

If you purchase a single-node, dual-node, or multi-node cloud disk instance, modification can be 

performed directly.

Sorting Rules of Character Set: The instance character set provides sorting rules for system data, 

namely, distinguishing between case-sensitive attributes and accent attributes. The Chinese_PRC_CI_AS 

is supported by default.

If a two-node local disk instance is purchased, submit a ticket  to apply for the modification of the 

rules for the character set.

If you purchase a single-node, dual-node, or multi-node cloud disk instance, modification can be 

performed directly.

Project: TencentDB for SQL Server supports assigning instances to different projects for management. 

You can perform fuzzy search for projects by name.

https://intl.cloud.tencent.com/document/product/238/32562
https://console.intl.cloud.tencent.com/workorder/category
https://console.intl.cloud.tencent.com/workorder/category
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Step 3. Confirm the configuration info

Display the configuration details of instances in step one and step two. If modifications are needed, click 

Edit. After all settings are confirmed, enable auto-renewal, read and agree to terms of the service, and click 

Purchase Now.

After the purchase is completed, return to the Instance List  and view the created instance. Once the status 

changes to Running, the instance is created successfully.

1. In the instance list , click an instance ID or Manage in the Operation column to enter the instance 

management page.

2. On the instance management page, select Account Management > Create Account and enter relevant 

information in the pop-up window. After confirming that everything is correct, click OK.

1. In the instance list , click an instance ID or Manage in the Operation column to enter the instance 

management page.

2. On the Instance Management page, choose Database Management > Create Database, set 

configuration items in the pop-up window, confirm that everything is correct, and click OK.

Tag: You can use tags to easily categorize and manage resources. You are allowed to add multiple tags.

Maintenance Window/Maintenance Time: The backend system performs maintenance operations on your 

TencentDB for SQL Server instance from time to time to ensure its stability. To minimize the potential 

impact on your business, we recommend that you set an acceptable maintenance period for your 

business instance, usually during off-peak hours. You can select up to all the seven options for the 

maintenance windows.

Auto-renewal (for monthly subscription billing mode): If auto-renewal is enabled and the account 

balance is sufficient, the instance will be automatically renewed upon expiration based on the selected 

purchase duration: monthly or annually.

Purchase duration of 1 to 11 months: The auto-renewal period is one month, and the instance will be 

automatically renewed on a monthly basis upon expiration.

Purchase duration of 1 to 5 years: The auto-renewal period is one year, and the instance will be 

automatically renewed on a yearly basis upon expiration, with an auto-renewal discount applied.

Terms of service: Cloud database service terms , Service level agreement , and Refund instruction .

Creating an Account

Note:

The created account name and password will be used when connecting to TencentDB for SQL 

Server. Store them properly.

Creating a Database

Database Name: It can contain up to 32 letters, digits, and underscores and must start with a letter.

https://console.intl.cloud.tencent.com/sqlserver#/
https://console.intl.cloud.tencent.com/sqlserver
https://console.intl.cloud.tencent.com/sqlserver
https://intl.cloud.tencent.com/zh/document/product/301/62707?has_map=1
https://intl.cloud.tencent.com/zh/document/product/301/62706?has_map=1
https://intl.cloud.tencent.com/document/product/238/31431?has_map=1
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Character Set: Select the character set to be used by the database. Currently, most native character 

sets are supported.

Authorize Account: You can authorize existing accounts to access the database. If you haven't created 

an account yet, see Creating an account .

Remarks: Enter remarks of up to 256 characters.

Related APIs

API Description

CreateDBInstances ﻿
This API is used to create high-availability instances (local 

disk).

CreateBasicDBInstances ﻿
This API is used to create basic edition instances (cloud 

disk).

CreateCloudDBInstances ﻿
This API is used to create high-availability instances (cloud 

disk).

DescribeRegions ﻿ This API is used to query purchasable regions.

DescribeZones ﻿ This API is used to query currently purchasable AZs.

DescribeProductConfig ﻿
This API is used to query purchasable specification 

configuration.

DescribeSpecSellStatus ﻿

This API is used to query the status information on 

specifications, including the sales status and reference 

price. (The actual price is subject to the result returned by 

price querying APIs.)

InquiryPriceCreateDBInstances ﻿ This API is used to query the price of requested instances.

DescribeOrders ﻿ This API is used to query order information.

DescribeInstanceByOrders ﻿
This API is used to query the instance ID by the order 

number.

https://intl.cloud.tencent.com/document/product/238/32119
https://intl.cloud.tencent.com/document/product/238/66344
https://intl.cloud.tencent.com/document/product/238/55674
https://intl.cloud.tencent.com/document/product/238/32111
https://intl.cloud.tencent.com/document/product/238/32109
https://intl.cloud.tencent.com/document/product/238/32112
https://intl.cloud.tencent.com/document/product/238/72699
https://intl.cloud.tencent.com/document/product/238/32108
https://intl.cloud.tencent.com/document/product/238/32134
https://intl.cloud.tencent.com/document/product/238/56942
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Connecting to TencentDB for SQL Server

Instance

Instance Connection Scenarios
Last updated：2024-01-18 17:16:54

This document describes some scenarios and methods of connecting to a TencentDB for SQL Server 

instance from a Windows CVM instance or local Windows system through SQL Server Management Studio 

(SSMS). For detailed directions, see Connecting to TencentDB for SQL Server Instance from Windows CVM 

Instance  and Connecting to TencentDB for SQL Server Instance from Local System .

The CVM and TencentDB for SQL Server instances are in the same VPC or classic network in the same 

region under the same Tencent Cloud root account.


Example: Under account 1, the CVM instance is in subnet A in VPC 1 in Guangzhou region, and the 

TencentDB for SQL Server instance is in subnet B in VPC 1 in Guangzhou region.


Connection method: Connect them over the private network.

The CVM and TencentDB for SQL Server instances are in different VPCs in the same region under the same 

Tencent Cloud root account.


Example: Under account 1, the CVM instance is in subnet A in VPC 1 in Guangzhou region, and the 

TencentDB for SQL Server instance is in subnet B in VPC 2 in Guangzhou region.


Connection method: We recommend that you connect them through CCN.

The CVM and TencentDB for SQL Server instances are in different regions under the same Tencent Cloud 

root account.


Example: Under account 1, the CVM instance is in subnet A in VPC 1 in Guangzhou region, and the 

TencentDB for SQL Server instance is in subnet B in VPC 2 in Beijing region.


Connection method: We recommend that you connect them through CCN.

Connecting to a TencentDB for SQL Server Instance from a Windows 

CVM Instance

Scenario 1

Scenario 2

Scenario 3

Scenario 4

https://intl.cloud.tencent.com/document/product/238/11626
https://intl.cloud.tencent.com/document/product/238/11627
https://intl.cloud.tencent.com/document/product/1003/31985
https://intl.cloud.tencent.com/document/product/1003/31985
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The CVM and TencentDB for SQL Server instances are under different Tencent Cloud root accounts.


Example: The CVM instance is in subnet A in VPC 1 in Guangzhou region under account 1, and the 

TencentDB for SQL Server instance is in subnet B in VPC 2 in Beijing region under account 2.


Connection method: We recommend that you connect them through CCN.

Connecting to a TencentDB for SQL Server Instance from a Local 

Windows System

Two-node (formerly High Availability/Cluster Edition) instance

Option 1: Use VPN , or Direct Connect , or CCN for interconnection, which are more secure and stable.

Option 2: Connect to the instance over the public network by enabling the public network address or 

binding the instance to CLB to enable public network access in the console as instructed in Connecting 

to TencentDB for SQL Server Instance from Local System .

Option 3: Use a Linux CVM instance with a public IP to map the ports as instructed in Connecting to 

TencentDB for SQL Server Instance from Local System .

Single-node (formerly Basic Edition) instance

Option 1: Use VPN , or Direct Connect , or CCN for interconnection, which are more secure and stable.

Option 2: Connect to the instance over the public network by enabling the public network address in the 

console as instructed in Connecting to TencentDB for SQL Server Instance from Local System .

Option 3: Use a Linux CVM instance with a public IP to map the ports as instructed in Connecting to 

TencentDB for SQL Server Instance from Local System .

https://intl.cloud.tencent.com/document/product/1003/31985
https://intl.cloud.tencent.com/document/product/1037/32679
https://intl.cloud.tencent.com/document/product/216/7557
https://intl.cloud.tencent.com/document/product/1003/31985
https://intl.cloud.tencent.com/document/product/238/11627
https://intl.cloud.tencent.com/document/product/238/11627#WWIPLJSL
https://intl.cloud.tencent.com/document/product/1037/32679
https://intl.cloud.tencent.com/document/product/216/7557
https://intl.cloud.tencent.com/document/product/1003/31985
https://intl.cloud.tencent.com/document/product/238/11627#kqwwdz
https://intl.cloud.tencent.com/document/product/238/11627#WWIPLJSL
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Connecting to TencentDB for SQL Server

Instance from Windows CVM Instance
Last updated：2024-11-12 16:28:36

This document describes how to connect to a TencentDB for SQL Server instance through SQL Server 

Management Studio (SSMS) on a Windows CVM instance and run a simple query.

1. Log in to the TencentDB for SQL Server console , click the instance ID of the target instance to enter 

the instance management page.

2. Based on the actual connection needs, you can view the private IP and port number of the instance at 

the top of the instance management page, in the instance information on the right side of the Instance 

Details page, or in the topology diagram. The specific scenarios are as follows.

Overview

Note: 

The CVM and TencentDB instances are better to be under the same account and in the same 

VPC in the same region.

CVM and TencentDB instances in the same VPC in different AZs in the same region can directly 

interconnect through private IPs.

CVM and TencentDB instances in different regions or VPCs or under different accounts can 

interconnect through Peering Connection  or CCN .

Directions

If the current instance is a two-node instance, you can view the private IP and port number of the 

primary node at the top. By hovering the mouse over the corresponding area in the topology 

diagram, you can view the private IP and port number of the corresponding node. In the instance 

information on the right side, you can view the private IP and port number of the primary node, 

replica node (if the replica node read-only feature is enabled), and read-only instances (if any).

https://console.intl.cloud.tencent.com/sqlserver
https://intl.cloud.tencent.com/document/product/553/18836
https://intl.cloud.tencent.com/document/product/1003/31985
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If the current instance is a single-node instance, you can view the private IP and port number of the 

primary node at the top, by hovering the mouse over the primary node read-write address in the 

topology diagram, or in the instance information on the right side.
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3. Log in to the Windows CVM instance. For more information, see Customizing Windows CVM 

Configurations . This document uses Windows Server 2012 R2 Standard Edition (64-bit) as an example.

4. Download and install SQL Server Management Studio  (SSMS) on the Windows CVM instance. For more 

information on SSMS, see What is SQL Server Management Studio (SSMS)? ﻿

5. Start SSMS in the Windows CVM instance. On the Connect to server page, enter the relevant 

information to connect to TencentDB. Click Connect and wait a few minutes before SSMS connects to 

your database instance.

6. Once connected to the database, you can view the standard built-in system databases (master, model, 

msdb and tempdb) of SQL Server.


If the current instance is a read-only instance, you cannot view the private IP and port number of 

the read-only instance in the topology diagram, but can view them at the top or in the instance 

information on the right side.

Server type: Select Database Engine.

Server name: Enter the private IP and port number of the instance and separate them by comma. 

For example, if the private IP of the instance is �b�� �� �� �� �� �� �� �� �� �� �� �b and the port number is �b�� �� �� �� �b, 

then enter �b�� �� �� �� �� �� �� �� �� �� �� �� �� �� �� �� �b here.

Authentication: Select SQL Server Authentication.

Login and Password: Enter the account name and password you configured when creating the 

instance account on the Account Management page.

https://intl.cloud.tencent.com/document/product/213/10516
https://docs.microsoft.com/en-us/sql/ssms/download-sql-server-management-studio-ssms
https://docs.microsoft.com/en-us/sql/ssms/sql-server-management-studio-ssms?view=sql-server-ver15
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7. You can start creating your own databases and running queries for them. Select File > New > Query 

with Current Connection and type the following SQL query:

�V�H�O�H�F�W�� �#�#�9�(�5�6�,�2�1
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Run the query. SSMS returns the TencentDB for SQL Server instance.
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Connecting to TencentDB for SQL Server

Instance from Local System
Last updated：2024-11-13 20:00:03

This document describes how to connect to a TencentDB for SQL Server instance through SQL Server 

Management Studio (SSMS), and run a simple query.

The connection methods vary by TencentDB instance type:


You can connect to a two-node TencentDB for SQL Server instance (formerly high-availability 

edition/cluster editions) from a local system in the following three methods:

You can connect to a single-node TencentDB for SQL Server instance (formerly basic edition) from a local 

system in the following three methods:

The following are connection options:

2. Select the region and click the ID or Manage in the Operation column of the target instance in the 

instance list.

Connection scenarios

Option 1: Use VPN , or Direct Connect , or CCN for interconnection, which are more secure and stable.

Option 2: Connect to the instance over the public network by enabling the public network address  or 

binding the instance to CLB to enable public network access  in the console.

Option 3: Use a Linux CVM instance with a public IP to map the ports .

Option 1: Use VPN , or Direct Connect , or CCN for interconnection, which are more secure and stable.

Option 2: Connect to the instance over the public network by enabling the public network address  in the 

console.

Option 3: Use a Linux CVM instance with a public IP to map the ports .

Enabling the public network address in the console and connecting to the TencentDB for SQL Server 

instance from a local system through SSMS.

Binding the TencentDB for SQL Server instance to CLB and connecting to the instance from a local 

system through SSMS.

Using a Linux CVM instance with a public IP to map the ports and connecting to the instance from a 

local system through SSMS

Enabling the public network address in the console and connecting to the 

TencentDB for SQL Server instance from a local system through SSMS

Step 1. Enable the public network address

1. Log in to the TencentDB for SQL Server console .

https://intl.cloud.tencent.com/document/product/1037/32679
https://intl.cloud.tencent.com/document/product/216/7557
https://intl.cloud.tencent.com/document/product/1003/31985
https://intl.cloud.tencent.com/document/product/1037/32679
https://intl.cloud.tencent.com/document/product/216/7557
https://intl.cloud.tencent.com/document/product/1003/31985
https://intl.cloud.tencent.com/document/product/238/11627
https://console.intl.cloud.tencent.com/sqlserver
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3. In the Instance Info on the Instance Details page, click Enable next to the Public Network Address.

4. In the Enabling public network window, read the note, indicate your consent, and click OK.

5. After public network access is enabled, view the public IP address and port number of the instance in 

Basic Info on the Instance Details tab.

1. Download and install SQL Server Management Studio  locally. For more information on SSMS, see Using 

SQL Server Management Studio .

2. Start SSMS locally. On the Connect to server page, enter the relevant information to connect to 

TencentDB. Click Connect and wait a few minutes before SSMS connects to your database instance.

3. Once connected to the database, you can view the standard built-in system databases (master, model, 

msdb and tempdb) of SQL Server.


Note: 

For the detailed notes and steps of enabling public network access, see Enabling/Disabling 

Public Network Address .

Step 2. Connect to the TencentDB for SQL Server instance over the public 

network

Server type: Select Database Engine.

Server name: Enter the public IP address and port number of the instance and separate them by 

comma.

Authentication: Select SQL Server Authentication.

Login and Password: Enter the account name and password you configured when creating the 

instance account on the Account Management page.


https://docs.microsoft.com/en-us/sql/ssms/download-sql-server-management-studio-ssms?view=sql-server-ver16
https://docs.microsoft.com/en/sql/ssms/sql-server-management-studio-ssms?view=sql-server-ver15
https://intl.cloud.tencent.com/document/product/238/50230
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4. Now you can start creating your own databases and running queries for them. Select File > New > Query 

with Current Connection and type the following SQL query:

�V�H�O�H�F�W�� �#�#�9�(�5�6�,�2�1
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Run the query. SSMS returns the TencentDB for SQL Server instance.


Go to the CLB purchase page , select the configuration, and click Buy Now.

Binding the TencentDB for SQL Server instance to CLB to enable public 

network access and connecting to the instance from a local system 

through SSMS

Step 1. Purchase a CLB instance

Note: 

If you already have a CLB instance in the same region as TencentDB for SQL Server, skip this step.

Note: 

Region: You need to select the region where the TencentDB for SQL Server instance is.

Network: You can select the same VPC as the instance or a different one.

https://buy.intl.cloud.tencent.com/clb
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1. Enable cross-VPC access (you can skip this step if the CLB instance and TencentDB for SQL Server 

instance are in the same VPC)


a. Log in to the CLB Console , select the region, and click the instance ID in the instance list to enter the 

management page.


b. On the Basic information page, click Configure in the Backend server section.


c. In the pop-up window, click Submit.

2. Configure a public network listener port


a. Log in to the CLB Console , select the region, and click the instance ID in the instance list to enter the 

management page.


b. On the instance management page, select the Listener management tab and click Create below 

TCP/UDP/TCP SSL/QUIC listener.

c. In the pop-up window, complete the settings and click Submit.

Step 2. Configure CLB Configuration

https://console.intl.cloud.tencent.com/clb/instance?rid=1
https://console.intl.cloud.tencent.com/clb/instance?rid=1
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1. After creating the listener, click it in Listener management and click Bind on the right.

2. In the pop-up window, select Other Private IPs as the object type, enter the IP address and port of the 

TencentDB for SQL Server instance, and click OK.

1. Log in to the TencentDB for SQL Server console . Select a region, click an instance ID in the instance list 

or Manage in the Operation column to access the instance management page.

2. On the instance management page, select the Security Group tab, click Configure Security Group, 

configure the security group rule to open all ports, and confirm that the security group allows access 

from public IPs. For more information on configuration, see Configuring Security Group .

Step 3. Bind a TencentDB for SQL Server instance

Note: 

The login account must be a standard account (bill-by-IP). If binding fails, submit a ticket  for 

assistance.

Step 4. Configure the TencentDB for SQL Server security group

Step 5. Connect to the TencentDB for SQL Server instance over the public 

network

https://console.intl.cloud.tencent.com/sqlserver
https://intl.cloud.tencent.com/document/product/238/35789
https://console.intl.cloud.tencent.com/workorder/category
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1. Download and install SQL Server Management Studio  locally. For more information on SSMS, please 

see Using SQL Server Management Studio .

2. Start SSMS locally. On the Connect to server page, enter the relevant information to connect to 

TencentDB. Click Connect and wait a few minutes before SSMS connects to your database instance.

3. Once connected to the database, you can view the standard built-in system databases (master, model, 

msdb and tempdb) of SQL Server.


Server type: Select Database Engine.

Server name: Enter the local IP address and port number of the CLB instance and separate them by 

a comma, such as �b�� �� �� �� �� �� �� �� �� �� �� �� �� �b.

Authentication: Select SQL Server Authentication.

Login and Password: Enter the account name and password you configured when creating the 

instance account on the Account Management page.


https://docs.microsoft.com/en-us/sql/ssms/download-sql-server-management-studio-ssms?view=sql-server-ver16
https://docs.microsoft.com/en/sql/ssms/sql-server-management-studio-ssms?view=sql-server-ver15
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4. Now you can start creating your own databases and running queries for them. Select File > New > Query 

with Current Connection and type the following SQL query:

�V�H�O�H�F�W�� �#�#�9�(�5�6�,�2�1
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Run the query. SSMS returns the TencentDB for SQL Server instance.


1. Log in to the TencentDB for SQL Server console . View the private IP and port number of the instance on 

the Instance Details page. The private IP and port number will be used for port mapping configuration.

Using a linux CVM instance with a public IP to map the ports and 

connecting to the instance from a local system through SSMS

Note: 

The CVM and TencentDB instances must be under the same account and in the same VPC in 

the same region.

For data security considerations, TencentDB for SQL Server doesn't support public IP. If you 

need to use a public IP, you can use the port mapping feature of SSH2 to connect to, configure, 

and manage an instance from the internet.

https://console.intl.cloud.tencent.com/sqlserver
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2. Prepare a Linux-based CVM instance with a public IP. For more information , see Customizing Linux 

CVM Configurations .

3. Log in to the Linux CVM instance locally with an SSH tool such as SecureCRT (as demonstrated in this 

document). For the login method, see Logging in to Linux Instance (Web Shell) .

4. Select Options > Session Options in the SecureCRT menu bar to enter the session properties settings.


5. On the session properties settings page, select Connection > Port Forwarding > Add to enter the port 

mapping configuration page.


https://intl.cloud.tencent.com/document/product/213/10517
https://intl.cloud.tencent.com/document/product/213/5436
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6. On the port mapping configuration page, configure the corresponding parameters.
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7. Download and install SQL Server Management Studio  (SSMS) locally. For more information on SSMS, 

see Use SQL Server Management Studio .

8. Start SSMS locally. On the Connect to server page, enter the relevant information to connect to 

TencentDB. Click Connect and wait a few minutes before SSMS connects to your database instance.

Server type: Select Database Engine.

Server name: enter the local IP address and port number and separate them with a comma, such as 

�b�� �� �� �� �� �� �� �� �� �� �� �� �� �b. The port number should be the same as that configured in step 6.

Authentication: Select SQL Server Authentication.

Login and Password: Enter the account name and password you configured when creating the 

instance account on the Account Management page.


https://docs.microsoft.com/en-us/sql/ssms/download-sql-server-management-studio-ssms
https://docs.microsoft.com/en/sql/ssms/sql-server-management-studio-ssms?view=sql-server-ver15
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9. Once connected to the database, you can view the standard built-in system databases (master, model, 

msdb and tempdb) of SQL Server.


10. Now you can start creating your own databases and running queries for them. Select File > New > 

Query with Current Connection and type the following SQL query:
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Run the query. SSMS returns the TencentDB for SQL Server instance.


�V�H�O�H�F�W�� �#�#�9�(�5�6�,�2�1
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Managing TencentDB for SQL Server

Instance
Last updated：2025-09-04 11:22:51

Log in to the TencentDB for SQL Server console , and enter the instance list page to view the instance 

information and manage your instances.

Instance List Page

Feature Description

Restart

In the instance list, select an instance and click Restart at the top to restart it. You can 

also select multiple instances for batch restart.

The instance will be inaccessible during the restart, and existing connections to it 

will be closed. 

If the number of business writes is high during the restart, the restart will fail. In 

this case, the instance will go back to the state before the restart and become 

accessible. 

Restart the instance during off-peak hours to ensure success and minimize the 

impact on your business.

Renew
In the instance list, select one or more target instances, click Renew to renew them by 

month or year.

Set Auto-

Renewal

In the instance list, select one or more target instances, and click More > Set Auto-

Renewal to set monthly auto-renewal for them. After you click OK, the instances will 

be automatically renewed monthly upon expiration if your Tencent Cloud account 

balance is sufficient.

Disable 

Auto-

Renewal

In the instance list, select one or more target instances marked with Renew before 

their name, click More > Disable Auto-Renewal, and click OK.

Edit Tag

You can click More > Edit Tag above the instance list or in the Operation column of an 

instance to manage its tags. If you haven't created a tag, you can click Tag 

Management to create one.

https://console.intl.cloud.tencent.com/sqlserver
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Log in to the TencentDB for SQL Server console . In the instance list, click the Instance ID or Manage in the 

Operation column to access the instance management page, where you can view its details, monitor it, and 

manage databases.

Adjust 

Configurati

on 

In the instance list, you can adjust the configuration of your database instance. Both 

instance upgrade and disaster recovery mode adjustment are supported. For more 

information, see Overview .

Publish/Su

bscribe

In the instance list, you can select More > Publish/Subscribe in the Operation column 

of an instance to perform publish/subscribe to meet the data replication and sync 

requirements of your business.

Terminatio

n/Return

In the instance list, you can select More > Terminate/Return to terminate/return a 

database instance. For more information, see Terminating Instance .

Switch to 

Monthly 

Subscriptio

n

You can switch the instances from pay-as-you-go to monthly subscription. In the 

instance list, click More > Switch to Monthly Subscription in the Operation column, 

select renewal period, and click OK after reading the rules.

Read-Only 

Instance

In the instance list, you can click More > Read-Only Instance in the Operation column 

of an instance to view its read-only instances and configure the RO group. If there are 

no read-only instances, you can click Create after redirection to add one or more 

read-only instances.

Instance Management Page

https://console.intl.cloud.tencent.com/sqlserver
https://intl.cloud.tencent.com/document/product/238/44352
https://intl.cloud.tencent.com/document/product/238/35787
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Feature Description

Instance 

Details

On the Instance Detail tab, you can view and manage various information of your 

databases, including setting maintenance information and adding read-only instances in 

the instance architecture diagram.

System 

Monitorin

g

On the Instance Monitor tab, you can view the monitoring data of various core metrics 

of the current database. For more information, please see Monitoring Feature  and 

Alarming Feature .

Backup 

and 

Restorati

on

On the Backup and Restoration tab, you can query the backup and restoration records 

and create a backup and restoration task. Supported backup upload methods include 

uploading file and downloading file from COS, and supported restoration modes include 

full backup file, full backups + logs, and full backups + differential backups.

Publish/S

ubscribe

On the Publish/Subscribe tab, you can create or delete one or more publish/subscribe 

linkage services. For details, see Publish-Subscribe .

Security 

Group

On the Security Group tab, you can configure security groups for your databases. For 

more information, see Configuring Security Group .

Account On the Account Management tab, you can manage the administrator account, such as 

https://intl.cloud.tencent.com/document/product/238/46503
https://intl.cloud.tencent.com/document/product/238/46501
https://intl.cloud.tencent.com/document/product/238/48063!823c77f5244a61cbb13cb489c954908f
https://intl.cloud.tencent.com/document/product/238/35789
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In the instance list, click the Instance ID or Manage in the Operation column to enter the instance 

management page, and then select the Instance Details page. On the Instance Details page, you can view 

and manage the instance information such as the instance architecture diagram, corresponding node 

addresses, storage and backup status, etc.

Single-Node Instance

The Instance Details page of a single-node instance is shown below:

Managem

ent

modifying permissions and resetting password. You can also create and delete 

accounts. For more information, see Creating Account .

Database 

Managem

ent

On the Database Management tab, you can create, delete, and set permissions of 

databases. For more information, see Database Management .

Read-

Only 

Instances

On the Read-Only Instance tab, you can create one or more read-only (RO) instances, 

which can be applied to read/write separation and one-primary-multiple-replica 

application scenarios to boost the read load capacity of your databases. For more 

information, see Read-Only Instance Overview .

Backup 

Managem

ent

On the Backup and Restoration tab, you can manually create, download, and restore 

backups. You can also set scheduled backups, and perform rollbacks. For more 

information, see Backup Management .

Operation 

Log

On the Operation Log tab, you can download the slow logs, enable blocking and 

deadlock event collection, and query blocking and deadlock event records.

Paramete

r 

Configura

tion

On the Parameter Configuration tab, you can view and modify certain parameters and 

query the parameter modification logs. For more information, see Parameter 

Configuration .

Data 

Security

On the Data Security tab, you can enable transparent data encryption and set up 

encrypted databases, or enable SSL encryption. For details, see Transparent Data 

Encryption  and Setting SSL Encryption .

Instance Details Page

https://intl.cloud.tencent.com/document/product/238/7521
https://intl.cloud.tencent.com/document/product/238/35780
https://intl.cloud.tencent.com/document/product/238/43142
https://intl.cloud.tencent.com/document/product/238/45853
https://intl.cloud.tencent.com/document/product/238/41609
https://intl.cloud.tencent.com/document/product/238/57471
https://intl.cloud.tencent.com/document/product/238/58634!a5443e3fbb0c56519da9ba01601ae24f
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Featur

e Area 
Illustration Feature Description

Top 

inform

ation

Renamin

g 

instance

s

Instance names are primarily used to differentiate 

and manage SQL Server instances. For details, 

seeRenaming Instance .

Migratin

g across 

AZs

Migrate the instance to another AZ within the 

same region. For details, see Migrating Across 

AZs .

Switch 

to 

Monthly 

Subscrip

tion

Switch the instance billing mode from pay-as-

you-go to monthly subscription. For details, see 

From Pay-as-You-Go to Monthly Subscription .

Renewal 

Manage

ment

Renew instances in the billing mode of monthly 

subscription. For details, see Renewal 

Instructions .

Tag

You can use the tags to perform classified 

management on the TencentDB for SQL Server 

resources. For details, see Setting Instance Tag .

Switch 

to 

Assign instances to different projects for 

management. For details, see Setting Instance 

Project .

https://intl.cloud.tencent.com/document/product/238/46508
https://intl.cloud.tencent.com/document/product/238/42695
https://intl.cloud.tencent.com/document/product/238/60165
https://intl.cloud.tencent.com/document/product/238/60164
https://intl.cloud.tencent.com/document/product/238/46506
https://intl.cloud.tencent.com/document/product/238/35786
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Another 

Project

Instance 

Remarks

Set or modify instance remarks for easier 

distinction and management of instances. For 

details, see Setting Instance Remarks .

Maintena

nce 

cycle 

and time

Set the maintenance cycle and maintenance time 

for the instance. For details, see Setting Instance 

Maintenance Information .

Topolo

gy 

diagra

m 

(archit

ecture 

diagra

m)

Primary 

Node 

Read-

Write 

Address

You can hover the mouse over the primary node 

read-write address in the topology diagram to 

quickly view the private or public network 

address of the primary node. If the public 

network address is not enabled, you can click 

Enable. For details, see Enabling Public Network 

Address .

Primary 

Node

You can hover the mouse over the primary node 

in the topology diagram to quickly view the 

instance name and the private or public network 

address of the primary node. If the public 

network address is not enabled, you can click 

Enable. For details, seeEnabling Public Network 

Address .

Primary 

node 

storage

You can hover the mouse over the primary node 

storage in the topology diagram to view the 

storage space usage of the instance. Click 

Scale-out to enter the configuration adjustment 

page for setup.

Local 

Backup

You can hover the mouse over the local backup 

in the topology diagram to view the details of 

local backups, such as total backup, data backup, 

log backup, and actual occupied space/total free 

space quota. Click Manage Backup to enter the 

backup space page for management. For details, 

see Viewing Backup Space .

Cross-

Region 

If cross-region backup is not enabled, you can 

click the + icon on the cross-region backup in 

https://intl.cloud.tencent.com/document/product/238/46507
https://intl.cloud.tencent.com/document/product/238/35785
https://intl.cloud.tencent.com/document/product/238/50230
https://intl.cloud.tencent.com/document/product/238/50230
https://intl.cloud.tencent.com/document/product/238/45850
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Two-node Instance

The Instance Details page of a two-node instance is shown below:

Backup the topology diagram to enable it.

If cross-region backup is enabled, you can hover 

the mouse over the cross-region backup in the 

topology diagram to view its detailed usage.

Topology 

diagram 

view 

scale

You can adjust the display scale of the topology 

diagram.

Instanc

e 

inform

ation 

(on the 

right 

side)

Hiding/S

howing 

instance 

informati

on

You can hide or show the instance information 

section.

Primary 

node 

informati

on

Under the primary node on the right side, you can 

view the primary node information such as 

private network address, public network address, 

network, configuration, instance status, edition, 

and architecture.

Operations that can be performed include 

changing network , enabling public network 

address , and adjusting configuration .

https://intl.cloud.tencent.com/document/product/238/46497
https://intl.cloud.tencent.com/document/product/238/50230
https://intl.cloud.tencent.com/document/product/238/44352
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Featur

e Area
Illustration Feature Description

Top 

inform

ation

Renamin

g 

instance

s

Instance names are primarily used to differentiate 

and manage SQL Server instances. For details, 

see Renaming Instance .

Migratin

g across 

AZs

Migrate the instance to another AZ within the 

same region. For details, see Migrating Across 

AZs .

Switch 

to 

Monthly 

Subscrip

tion

Switch the instance billing mode from pay-as-

you-go to monthly subscription. For details, see 

From Pay-as-You-Go to Monthly Subscription .

Renewal Renew instances in the billing mode of monthly 

https://intl.cloud.tencent.com/document/product/238/46508
https://intl.cloud.tencent.com/document/product/238/42695
https://intl.cloud.tencent.com/document/product/238/60165
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Manage

ment

subscription. For details, see Renewal 

Instructions .

Tag

You can use the tags to perform classified 

management on the TencentDB for SQL Server 

resources. For details, see Setting Instance Tag .

Switch 

to 

Another 

Project

Assign instances to different projects for 

management. For details, seeSetting Instance 

Project .

Instance 

Remarks

Set or modify the instance remarks for easier 

distinction and management of instances. For 

details, see Setting Instance Remarks .

Maintena

nce 

cycle 

and time

Set the maintenance cycle and maintenance time 

for the instance. For details, see Setting Instance 

Maintenance Information .

Topolo

gy 

diagra

m 

(archit

ecture 

diagra

m)

Primary 

node 

Read-

Write 

Address

You can hover the mouse over the primary node 

read-write address in the topology diagram to 

quickly view the private or public network 

address of the primary node. If the public 

network address is not enabled, you can click 

Enable. For details, see Enabling Public Network 

Address .

Replica 

Node 

Read-

Only 

Address

If the replica node read-only feature is not 

enabled, you can click the + icon on the replica 

node read-only address in the topology diagram 

to enable it.

If the replica node read-only feature is enabled, 

you can hover the mouse over the replica node 

read-only address in the topology diagram to 

quickly view the replica node read-only address. 

For details, see Replica Node Read-Only .

Read-

Only 

group 

address

If a read-only instance is created, the read-only 

group address section will be displayed. You can 

hover the mouse over the read-only group 

address in the topology diagram to quickly view 

the read-only group address and configure the 

read-only group. For details, see Read-Only 

Group .

https://intl.cloud.tencent.com/document/product/238/60164
https://intl.cloud.tencent.com/document/product/238/46506
https://intl.cloud.tencent.com/document/product/238/35786
https://intl.cloud.tencent.com/document/product/238/46507
https://intl.cloud.tencent.com/document/product/238/35785
https://intl.cloud.tencent.com/document/product/238/50230
https://intl.cloud.tencent.com/document/product/238/59510
https://intl.cloud.tencent.com/document/product/238/43144
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Primary 

Node

You can hover the mouse over the primary node 

in the topology diagram to quickly view the 

instance name and private or public network 

address of the primary node. If the public 

network address is not enabled, you can click 

Enable. For details, see Enabling Public Network 

Address .

Replica 

Node

If the replica node read-only feature is not 

enabled, information will not be displayed when 

you hover the mouse over the replica node in the 

topology diagram. At this time, the replica node 

is used for disaster recovery purposes.

If the replica node read-only feature is enabled, 

the read-only address of the replica node will be 

displayed when you hover the mouse over the 

replica node in the topology diagram. At this 

time, the replica node is used for read-only and 

disaster recovery purposes.

No matter whether the replica node read-only 

feature is enabled, you can click the switching 

icon on the replica node to perform manual 

switching between primary and replica nodes. For 

details, see Manual Primary-Replica Switching .

Read-

only 

instance

If a read-only instance has been created, the 

read-only instance section will be displayed. You 

can hover the mouse over the read-only instance 

in the topology diagram to quick view the private 

network address and public network address of 

the read-only instance. Click View Details to 

enter the corresponding read-only instance 

details page for viewing, or click the primary 

instance ID at the bottom right corner to return to 

the primary instance details page. You can also 

click the + icon on the read-only instance in the 

topology diagram to create a read-only instance.

Primary 

node 

storage

You can hover the mouse over the primary node 

storage in the topology diagram to view the 

storage space usage of the instance. The storage 

usage of the replica node is consistent with that 

of the primary node. Click Scale-out to enter the 

configuration adjustment page for setup.

https://intl.cloud.tencent.com/document/product/238/50230
https://intl.cloud.tencent.com/document/product/238/58244
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Read-

only 

instance 

storage

You can hover the mouse over the read-only 

instance storage in the topology diagram to view 

the storage space usage of the read-only 

instance. Click Scale-out to enter the 

configuration adjustment page for setup.

Local 

Backup

You can hover the mouse over the local backup 

in the topology diagram to view the details of 

local backups, such as total backup, data backup, 

log backup, and actual occupied space/total free 

space quota.

Cross-

Region 

Backup

If cross-region backup is not enabled, you can 

click the + icon on the cross-region backup in 

the topology diagram to enable it.

If cross-region backup is enabled, you can hover 

the mouse over the cross-region backup in the 

topology diagram to view its detailed usage.

Topology 

diagram 

view 

scale

You can adjust the display scale of the topology 

diagram.

Instanc

e 

inform

ation 

(on the 

right 

side)

Hiding/S

howing 

instance 

informati

on

You can hide or show the instance information 

section.

Primary 

Node 

Informati

on

Under the primary node on the right side, you can 

view the private network address, public network 

address, network, configuration, instance status, 

edition, and architecture information of the 

primary node.

Operations that can be performed include 

manual primary-replica switching , changing 

https://intl.cloud.tencent.com/document/product/238/58244
https://intl.cloud.tencent.com/document/product/238/46497
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Multi-node Instances

The instance details page for multi-node instances is shown in the following figure:

network , enabling public network address , and 

adjusting configuration .

Replica 

Node 

informati

on

Under the replica node on the right side, you can 

enable the replica node read-only feature. Once 

enabled, you can view the replica node read-only 

address. You can also view the replica node 

information such as network, AZ, instance status, 

and primary-replica transmission mode.

Operations that can be performed include 

enabling/disabling replica node read-only  and 

changing network .

Read-

Only 

Instance 

informati

on

Under the read-only instance on the right side, 

you can view the read-only instance information 

such as private network address, public network 

address, network, instance status, AZ, edition, 

architecture, configuration, and weight.

Operations that can be performed include 

switching to query information of other read-only 

instances, read-only group configuration , 

changing network , enabling public network 

address , and adjusting configuration .

https://intl.cloud.tencent.com/document/product/238/46497
https://intl.cloud.tencent.com/document/product/238/50230
https://intl.cloud.tencent.com/document/product/238/44352
https://intl.cloud.tencent.com/document/product/238/59510
https://intl.cloud.tencent.com/document/product/238/46497
https://intl.cloud.tencent.com/document/product/238/43144
https://intl.cloud.tencent.com/document/product/238/46497
https://intl.cloud.tencent.com/document/product/238/50230
https://intl.cloud.tencent.com/document/product/238/44352
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Featur

e Area
Figure Feature Description

Top 

inform

ation

Modify 

the 

instance 

name

The instance name is mainly used to distinguish 

and manage SQL Server instances. For details, 

see Modify Instance Name .

Migrate 

across 

AZs

Enable the migration of an instance to another 

availability zone within the same region. For 

details, see Cross-AZ Migration .

Switch 

to 

Monthly 

Subscrip

tion

Convert a pay-as-you-go instance to a monthly 

subscribed instance. For details, see Pay-as-

you-go to Monthly Subscription .

Renewal 

Manage

ment

Allow renewal for monthly subscribed instances. 

For details, see Renewal Instructions .

https://intl.cloud.tencent.com/document/product/238/46508
https://intl.cloud.tencent.com/document/product/238/42695
https://intl.cloud.tencent.com/document/product/238/60165
https://intl.cloud.tencent.com/document/product/238/60164
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Tag Tags can be used to classify and manage cloud 

database SQL Server resources. For details, see 

Set Instance Tags .

Switch 

to 

Another 

Project

Assign instances to different projects for 

management. For details, see Set Project to 

Which Instance Belongs .

Instance 

Remarks

Set or modify instance remarks for easier 

identification and management. For details, see 

Set Instance Remark .

Maintena

nce 

cycle 

and time

Configure the maintenance cycle and 

maintenance time for the instance. For details, 

see Set Instance Maintenance Information .

Topolo

gy 

(archit

ecture 

diagra

m)

Primary 

Node 

Read-

Write 

Address

Hover over the primary node read-write address 

in the topology to view its private or public 

network address quickly. If the public network 

address is not enabled, click Enable Public 

Network Address .

Replica 

Node 

Read-

Only 

Address

If read-only mode is not enabled for the 

secondary node, click the "+" on the secondary 

node read-only address in the topology to enable 

it.

If read-only mode is enabled for the secondary 

node, hover over the read-only address in the 

topology to query the address quickly. For 

details, see Replica Node Read-Only .

Primary 

Node

Hover over the primary node in the topology to 

quickly view its instance name and private/public 

network address. If the public network address is 

not enabled, click Enable Public Network 

Address .

Replica 

Node

If read-only mode is not enabled for the 

secondary node, hovering over the secondary 

node in the topology will not display any detailed 
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information, as the secondary node serves only 

for disaster recovery.

If read-only mode is enabled for the secondary 

node, hovering over the secondary node in the 

topology will display its read-only address, 

indicating that the node is used for read-only 

operations and disaster recovery.

Click the "+" in the topology to add a secondary 

node.

If you need to manually switch between primary 

and secondary nodes, see Manual 

Primary/Replica Switchover .

Primary 

node 

storage

Hovering over the primary node storage in the 

topology allows viewing the instance's storage 

usage. Storage usage for the secondary node is 

identical to that of the primary node. Click Scale 

Out to go to the configuration adjustment page.

Replica 

node 

storage

Storage usage for the secondary node is identical 

to that of the primary node.

Local 

Backup

Hovering over the local backup in the topology 

allows viewing details such as total backup size, 

data backup, log backup, and actual space 

usage/total free space quota.

Cross-

Region 

Backup

If cross-region backup is not enabled, click the 

"+" on the cross-region backup in the topology 

to enable it.

If cross-region backup is enabled, hovering over 

the cross-region backup in the topology allows 

viewing the usage details.

Topology 

view 

Adjust the display scale of the topology.
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scale

Instanc

e 

inform

ation 

(right 

side)

Showing

/Hiding 

instance 

informati

on

Show/Hide the instance information panel.

Primary 

Node 

informati

on

In the right-side primary node section, you can 

view details such as its private and public 

network addresses, associated network, 

configuration, instance status, version, and 

architecture.

Available operations include: Manual primary-

secondary switch , changing network , enabling 

public network address , and configuration 

adjustment .

Replica 

Node 

informati

on

In the right-side secondary node section, users 

can enable read-only mode. Once enabled, you 

can view details such as its read-only address, 

associated network, AZ, instance status, and 

primary-secondary transmission mode.

Available operations include:  Enabling or 

disabling read-only mode for secondary nodes  

and changing the network .

Related APIs

API Description

DescribeDBInstances ﻿ This API is used to query the list of instances.

DescribeDBInstancesAttribute ﻿ This API is used to query the attributes of an instance.

DescribeCrossRegionZone ﻿ This API is used to query the disaster recovery region and 
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AZ of the secondary node based on the primary instance.

DescribeCollationTimeZone ﻿
This API is used to query the character set and time zone 

supported by the instance.

DescribeFlowStatus ﻿ This API is used to query flow status.

DescribeInstanceTasks ﻿
This API is used to query the list of asynchronous tasks 

related to an instance.

ModifyDBInstanceName﻿ This API is used to rename an instance.

ModifyDBInstanceNote ﻿ This API is used to modify the instance remarks.

ModifyDBInstanceProject ﻿
This API is used to modify the project to which a database 

instance belongs.

DescribeUpgradeInstanceCheck ﻿
This API is used to pre-check the impact of the instance 

configuration adjustment before the adjustment.

UpgradeDBInstance This API is used to upgrade an instance.

CompleteExpansion ﻿

This API is used to complete the instance upgrade and 

switch immediately without waiting for the maintenance 

window when the instance status is "upgrade pending 

switch" after scale-out is initiated. This API needs to be 

called during off-peak hours of the instance. Some 

databases cannot be accessed before the switch is 

completed.

SwitchCloudInstanceHA﻿
This API is used to manually switch between primary and 

secondary.

RestartDBInstance ﻿ This API is used to restart a database instance.

TerminateDBInstance ﻿
This API is used to isolate an instance to move it into a 

recycle bin.

RenewPostpaidDBInstance ﻿

This API is used to recover the pay-as-you-go instance 

that is manually isolated through the API 

TerminateDBInstance from the recycle bin.

DeleteDBInstance ﻿
This API is used to release SQL server instances (eliminated 

immediately) in the recycle bin.

ModifyDBInstanceNetwork ﻿
This API is used to switch a running instance from a VPC to 

another.
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ModifyOpenWanIp ﻿ This API is used to enable the public network for the 

instance.

ModifyCloseWanIp ﻿
This API is used to disable the public network for the 

instance.
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